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The information provided in this documentation contains general descriptions and/or technical 
characteristics of the performance of the products contained herein. This documentation is not 
intended as a substitute for and is not to be used for determining suitability or reliability of these 
products for specific user applications. It is the duty of any such user or integrator to perform the 
appropriate and complete risk analysis, evaluation and testing of the products with respect to the 
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or 
subsidiaries shall be responsible or liable for misuse of the information contained herein. If you 
have any suggestions for improvements or amendments or have found errors in this publication, 
please notify us. 

No part of this document may be reproduced in any form or by any means, electronic or 
mechanical, including photocopying, without express written permission of Schneider Electric.

All pertinent state, regional, and local safety regulations must be observed when installing and 
using this product. For reasons of safety and to help ensure compliance with documented system 
data, only the manufacturer should perform repairs to components.

When devices are used for applications with technical safety requirements, the relevant 
instructions must be followed. 

Failure to use Schneider Electric software or approved software with our hardware products may 
result in injury, harm, or improper operating results.

Failure to observe this information can result in injury or equipment damage.

© 2013 Schneider Electric. All rights reserved.
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Safety Information

Important Information

NOTICE
Read these instructions carefully, and look at the equipment to become familiar with the device 
before trying to install, operate, or maintain it. The following special messages may appear 
throughout this documentation or on the equipment to warn of potential hazards or to call attention 
to information that clarifies or simplifies a procedure.
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PLEASE NOTE
Electrical equipment should be installed, operated, serviced, and maintained only by qualified 
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of 
the use of this material.

A qualified person is one who has skills and knowledge related to the construction and operation 
of electrical equipment and its installation, and has received safety training to recognize and avoid 
the hazards involved.
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About the Book

At a Glance

Document Scope
This manual describes the installation and the using of Unity DIF software.

Validity Note
This documentation is valid for Unity DIF version 8.0.

Related Documents

You can download these technical publications and other technical information from our website 
at www.schneider-electric.com.

Title of Documentation Reference Number

Unity Pro Software Reference Manual 35056144

Schneider Electric License Manager User Manual EIO0000001070
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Unity DIF
Overview
EIO0000001720 11/2013

Overview

Chapter 1
Overview

General Introduction

Overview
Unity DIF is a comparison software that compares the Unity Pro project files and displays the 
differences graphically with a similar look and feel of Unity Pro. This enables the user to understand 
the project differences easily. The result of the comparison is displayed in the Unity DIF main 
window, which can be printed/saved as .pdf or .txt format.

NOTE: The software compares the project files with .xef, .zef, .stu, and .sta extensions.

Function
The software provides differences of the following sections after comparison:

PLC configuration (Hardware and network)
Derived Data Types
Derived FB Types
Variables and FB Instance
Motion
Communication
Programs
Animation Table
Operator Screen
DTM Catalog
Project settings



Overview
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Unity DIF
Hardware and Software Requirements
EIO0000001720 11/2013

Hardware and Software Requirements

Chapter 2
Hardware and Software Requirements

Overview
This chapter describes the system requirements and the steps to install and activate the software.

What Is in This Chapter?
This chapter contains the following topics:

Topic Page

System Requirements 12

Installation and Uninstallation 14

License Activation 16
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System Requirements

Introduction
Unity DIF requires the following hardware and software configuration. The configuration type 
determines the level of expected performance.

The performance of Unity DIF software is affected by the following:
Opening several windows simultaneously
Accessing large quantities of animated data
Using a large application

Hardware Requirements
This table describes the minimum hardware requirements to run Unity DIF on Microsoft Windows 
7 Professional (32/64 bit), Windows 8 Pro (32/64 bit), and Windows Server 2008 R2 (64 bit):

NOTE: The installation of Windows 7 Service Pack 1 (SP1) is mandatory on Windows 7 (64 bit) 
system.

This table describes the minimum hardware requirements to run Unity DIF on Microsoft Windows 
XP Professional:

NOTE: Refer to Unity Pro readme for the minimum system requirements to install Unity Pro for 
comparing .stu and .sta files.

Requirement Minimum

System 2.4 GHz or higher

RAM 3 GB, Recommended 8 GB

Hard disk 50 GB

Monitor 1024 x 768 with high color 24 bit

Requirement Minimum

System Pentium Processor 1.2 GHz or higher

RAM 1 GB; Recommended 3 GB

Hard disk 5 GB; Recommended 10 GB

Monitor 1024 x 768 with high color 24 bit
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Software Requirements
Unity DIF installation requires the following software:

NOTE: The user needs Administrator access rights to install Unity DIF, but the User access rights 
are sufficient for using the software.

Unity DIF on a Virtual Machine
Unity DIF runs on the following virtual machines:

VMWare
VirtualBox

VMWare
VMWare requires the given configurations: 

VirtualBox
VirtualBox requires the given configurations: 

Software Edition Special Consideration

Microsoft.NET Framework V4.0 –

Operating System of VMware machine Operating System of Computer

Windows 7 (64 bit) Windows 7 (64 bit)

Optional Configurations

Windows 7 (32 bit) Windows 7 (32 bit)

Windows XP Windows 7 (64 bit)

Operating System of VirtualBox machine Operating System of Computer

Windows 7 (32 bit) Windows 7 (64 bit) (recommended)
Or Windows 7 (32 bit)
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Installation and Uninstallation

Introduction
This topic describes installation and uninstallation of Unity DIF.

How to Install
This table describes the installation of this software:

How to Uninstall
This table describes the steps to remove the software from your PC:

Step Action

1 Insert the Unity DIF CD-ROM.

2 Click setup.exe.
Result: InstallShield Wizard starts and the installation startup screen appears.

3 Click Next to continue.

4 After reading the read me, release notes, and license agreement, check I accept 
the terms of the license agreement option and click Next to continue.
NOTE: You can print the license agreement using Print option.

5 Enter the following information and click Next to continue:
First name
Last name
Company

NOTE: Check Only for Me option if you do not want to install the software for other 
users.

6 Select the folder where the setup has to install the files and click Next to continue.
NOTE: The default directory is C:\Program Files\Schneider Electric\.

7 Select Create a shortcut on the desktop option, Create a Quick Launch icon 
option and click Next to continue.

8 Click Install to configure and launch the installation.
Result: When the installation is complete, the exit screen appears.

Step Action

1 Click Start.

2 Select Settings → Control Panel.
Result: The Control Panel window appears displaying the categories.

3 Click Add or Remove Programs from the window.



Hardware and Software Requirements

EIO0000001720 11/2013 15

Installation over Existing Version
If an older version of Unity DIF is present, the setup removes the previous version (including 
documentation, samples, tools, and so on) before the installation of the new version.
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License Activation

Introduction
Unity DIF requires to be activated after 21 days of trail period to use for free. After the trail period, 
the tool cannot be launched.

The license can be activated on any number of systems. The conditions for activating the Unity DIF 
license on a PC are the following:

Activation is required after 21 days.
Activation is done by Web.
User has to enter the e-mail address for activation.
Return, update, and repair are not allowed.

How to Activate the License
This table describes the steps to activate the license of Unity DIF:

Step Action

1 Launch the Schneider Electric License Manager.

2 Click Activate in the Local tab.
Result: The Activation Method dialog box appears.

3 Select By web as activation method. 
Result: A short procedure description of this method is displayed in the text box. The user can print this 
description using the Print option.

4 Click Next.
Result: The Activation ID dialog box appears.

5 Enter the activation ID A-UJPB-FC95-L44U.
Result: The Next option is enabled.

6 Click Next.
Result: The E-mail Address dialog box opens.

NOTE: Refer to Activation Methods (see Schneider Electric License Manager, User Manual).
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7 Enter your e-mail address and repeat the entry in the second line.
NOTE: To activate a free tool, the user has to enter an e-mail address of a Web User Account.

NOTE: If you do not have a Web User Account, click the link as shown in the figure and follow the steps 
to create a new account. After the new account is created, you will get a confirmation mail on your given 
e-mail id. Click and activate to enable your account.

Result: The Next option is enabled.
NOTE: De-activate the Receive e-mails with news on Schneider Electric products option by not 
selecting the checkbox.

8 Click Next.
Result: The Activation in Progress dialog box opens. 
NOTE: The information about the internal processing of license activation is displayed in this text box.

9 Click Finish after the license is successfully created.
Result: The Local tab of the Schneider Electric License Manager is displayed with each activated 
license in a new line.

Step Action

NOTE: Refer to Activation Methods (see Schneider Electric License Manager, User Manual).
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Unity DIF
Using Unity DIF
EIO0000001720 11/2013

Using Unity DIF

Chapter 3
Using Unity DIF

Overview
This chapter describes the usage of this software.

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page

3.1 Launch 20

3.2 User Interface 23

3.3 Compare 36

3.4 Features 48
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Launch

Section 3.1
Launch

Launching Unity DIF

Overview
This section describes the launching of this software.

The user can launch the software using the following methods:
Launch from desktop
Launch in Windows environment
Launch from Unity Pro
Launch from Windows Context menu

How to Launch from the Desktop 
The normal installation process places a Unity DIF program icon on your desktop.

To launch the Unity DIF Software, double-click this icon. 

How to Launch in Windows Environment
This table describes the steps to launch the software in the Windows environment:

Step Action

1 Click Start.

2 Select Schneider Electric from All Programs.

3 Click SoCollaborative → Unity DIF from the program list.
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How to Launch from Unity Pro
This table describes the steps to launch the software from Unity Pro:

NOTE: 
The Project Comparison menu entry is disabled in the following cases:

If a project is not open in Unity Pro
Unity Pro is reinstalled
Unity DIF is uninstalled

It is enabled after Unity DIF is reinstalled.

How to Launch from Windows Context Menu
This table describes the steps to launch the software from Windows context menu:

Step Action

1 Click Tools from the menu bar.

2 Select Project Comparison.

3 Browse in Compare File field in the Open Files dialog box to select a file for comparison.
NOTE: The file that is currently open in Unity Pro is selected as the base file by default.

4 Click Compare to start the comparison.

Step Action

1 Right-click the selected Unity Pro project file.
Result: A Windows context menu appears.

2 Choose Select Base file to DIF option from the menu.
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3 Right-click the desired Unity Pro project file for comparison and select DIF with “xxx” 
option.

NOTE: The xxx represents the name of the base file that is selected.

Step Action
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User Interface

Section 3.2
User Interface

Overview
The DIF project window opens when the user launches the software. The Project Browser, Main 
Window, Attribute Window, and Result Window is displayed only after the comparison of the Unity 
Pro project files.

This window comprises of the following sections:
Project Browser
Main Window
Attribute Window
Result Window
Menus
Tool bar
Status bar
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This figure displays the DIF project window:

1 Project browser
2 Main window
3 Attribute window
4 Result window
5 Menus
6 Tool bar
7 Status bar
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What Is in This Section?
This section contains the following topics:

Topic Page

Project Browser 26

Main Window 28

Attribute Window 29

Result Window 30

Menus 31

Tool bar 33

Status bar 35



Using Unity DIF

26 EIO0000001720 11/2013

Project Browser

Introduction
The Project Browser displays the different sections of the project. The browser is aligned to the left 
side of the application window by default but it is movable either to right or left. The Project Browser 
structure is the combination of base and compared project nodes after comparison. The sections 
that are not selected for comparison are grayed out.

The user can select any node from the Project Browser and the corresponding node difference is 
displayed on the Main Window.

The main features of Project Browser are:
Sub menu
Key navigation

Sub Menu
The sub menu item Open files in Unity Pro enables the user to open the files in Unity Pro. Select 
this option by right-clicking the programming language section in the Project Browser. If Unity Pro 
is not installed on the PC, a popup appears displaying the message Unity Pro is not installed on 
this PC.

This feature is available only for the following programming languages:
IL: Instruction list
ST: Structured text
LD: Ladder diagram
FBD: Functional block diagram
LL984: Ladder logic 984
SFC: Sequential function chart

Key Navigation
The navigation keys include:

F7: Previous difference
F8: Next difference
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Icon Representation
This table displays the icon representation and its description:

The color schema for the icons (that is for added, modified, and deleted) differs with the selection 
of colors from Options (see page 53) menu.

Icons Description

Indicates the node modification.

Indicates the node deletion.

Indicates the node addition.

Indicates that the node is not compared.



Using Unity DIF

28 EIO0000001720 11/2013

Main Window

Introduction
The Main Window displays the difference results of a selected section from the base and compared 
files. The results are displayed in different formats (textual, graphical, and tabular), for better 
understanding of the user based on the section selected from the Project Browser.

Features of Main Window
This table describes the features of the Main Window:

Features Description

Navigation This feature helps the user to navigate through the differences.

Blank section If a section is not present either on the base or compared file, the 
corresponding data window of the file in which the section is not 
present remains blank.

Synchronization This feature synchronizes the scroll bars of the windows that 
display the data from the base and compared files. For more 
information, refer to Scrolling (see page 54).

Space pattern insertion The space pattern is inserted between lines and objects to match 
and show the corresponding difference in the base and compared 
files.

Difference highlighting The selection of a particular difference in the Result Window 
highlights the corresponding line or object in the Main Window 
and the associated object attributes in the Attribute Window.
The differences (that is added, modified, or deleted objects) in the 
sections are highlighted in various colors depending on the user 
selection. For more information, refer to Color Format 
(see page 53).

Textual representation The difference is displayed as 2 separate windows on the Main 
Window in textual format. The line number is shown for the 
sections that display the differences in textual format.

Graphical representation The selected sections from the base and compared files display 
their differences in graphical format.

Tabular representation The differences after comparison are displayed in tabular format 
for certain selected sections (Communication, Animation 
Table, Variables and FB Instances, Motion, and Project 
Settings).

Zoom-in and zoom-out Zoom-in and zoom-out are enabled for sections that display their 
differences in graphical format.
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Attribute Window

Introduction
The Attribute Window displays the attributes of the selected sections/nodes/variables.

Features of Attribute Window
The Attribute Window includes 3 columns, namely Attribute Name, Value in base file, and Value 
in Compared file.

The value field remains empty if the associated value is not available in the file. The color codes 
differentiate the changes for easy understanding.
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Result Window

Introduction
The result is displayed in the Result Window after the completion of comparison. The software 
uses Unity Pro vocabulary and syntax to display the attributes. The selection of a particular 
difference in the Result Window highlights the corresponding line or object on the Main Window.

Filters
The following filters are available for filtering the DIF results:

Added: Lists the added item.
Modified: Lists the modified items.
Deleted: Lists the deleted items.

NOTE: The icon representation of each result differentiates the changes when the filters are 
enabled.
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Menus

Introduction
The menu structure comprises of the following:

File
View
Tools
Help

Menu Structure
The functions of these menu items are described in the given table:

Menu Menu Item Shortcut Description

File Compare CTRL + M Enables the user to select the base and compared files for 
comparison using Open File dialog box.
For more information, refer to File Compare 
(see page 37).

XML View – Enables the user to view the source XML difference of a 
selected section using XML View.
For more information, refer to XML Source (see page 50).

Print Setup – Enables the user to configure the printer using Print 
Setup dialog box.

Print CTRL + P Enables the user to select the modified sections and print 
a difference report. This feature is enabled after 
comparison.
For more information, refer to Print (see page 51).

Exit CTRL + X Allows the user to stop and exit Unity DIF.
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View Toolbar – Allows the user to display or hide the Tool bar.
For more information, refer to Tool bar (see page 33).

Status bar – Allows the user to display or hide the Status bar.

Project Browser – Allows the user to display or hide the Project Browser.
For more information, refer to Project Browser 
(see page 26).

Full Screen Mode F5 Allows the user to view the differences in full screen 
without the menu bar, Tool bar, Status bar, and Project 
Browser.

Previous Difference F7 Allows the user to navigate to the previous and the next 
difference respectively after comparison.

Next Difference F8

Tools Option CTRL + O Allows the user to change the settings.
For more information, refer to Options (see page 53).

Help Index F1 Lists the help elements in the alphabetical order.

Find F1 Allows the user to search an element in the compared files 
using keywords.

Help Topics F1 Allows the user to navigate to help topics on any particular 
content in the file.

About Unity DIF – Opens the About window.

Menu Menu Item Shortcut Description
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Tool bar

Introduction
The toolbar consists of the following tool bar items:
1. Compare
2. XML view
3. Print
4. Full screen
5. Previous difference
6. Next difference
7. Help

Compare
The compare action opens the Open Files dialog box allowing the user to select the base and 
compare files for comparison. This option is disabled when the comparison is in-progress.

For more information, refer to File Compare (see page 37).

XML View
The XML View option displays the source XML differences of a selected section and is enabled 
after comparison.

For more information, refer to XML Source (see page 50).

Print
The Print option allows the user to select and print the difference report for the sections that have 
differences and is enabled after comparison.

For more information, refer to Print (see page 51).

Full Screen
The Full screen mode option enables the user to view the differences in full screen without the 
menu bar, Tool bar, Status bar, and Project Browser. This feature is enabled after comparison.

Previous Difference (F7)
This option allows the user to navigate to the previous difference and is enabled only after the 
comparison results are available.

To view the previous difference, click View → Previous difference from the menu bar or click the 
toolbar shortcut.
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Next Difference (F8)
This option allows the user to navigate to the next difference and is enabled only after the 
comparison results are available.

To view the next difference, click View → Next difference from the menu bar or click the toolbar 
shortcut.

Help
This option opens the online help in the content page.
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Status bar

Introduction
Status bar is visible at the bottom of the DIF project window when the software is launched. This 
is an option available in the View menu, which enables the user to display and hide the Status bar.

Features
This table describes the different Status bar messages and its instances:

Status bar Message Instance

Ready to compare When the user launches the software, this message is displayed in the 
Status bar.

File comparison is started When the user clicks Compare after the selection of the desired Unity Pro 
project files.

Compare in progress When the Unity Pro project files are being compared. 

Project Total Changes By default, when the root node is selected after the comparison is complete.
NOTE: The selection of different sections in the Project Browser displays the 
message Total Changes on the status bar for that particular section.
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Compare

Section 3.3
Compare

Overview
This section describes the steps to compare Unity Pro project files, file compatibility, and the 
compared and not compared elements.

What Is in This Section?
This section contains the following topics:

Topic Page

File Compare 37

Compatibility 39

Compared Elements 40
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File Compare

Introduction
The Compare option enables the user to select and compare 2 Unity Pro project files with .xef, 
.zef, .sta, or .stu extensions.

How to Compare
This table describes the steps to compare:

Step Action

1 Click File → Compare.

Result: The Open files dialog box appears.

2 Browse for the base and compare files in the respective fields.

NOTE: The software registers the information of the detected errors and warnings in a log file during the 
comparison process. The name of the log file is UnityDifError.log and it is located at %application 
path%/UnityDIF.
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Security Editor
A popup dialog box appears to verify the login credentials if the Security Editor feature is enabled 
on the PC during the comparison of .sta or .stu project files. The cancellation of this dialog or 
entering incorrect credentials stops the comparison.

This figure displays the Security Editor feature:

Click Cancel to stop the comparison.

3 Select or unselect the section that has to be compared.
NOTE: Select atleast one section to start the comparison.

4 Select the insignificant changes such as comments, positions, and so on if it needs to be 
compared.

5 Click Compare to start comparison.
NOTE: 

If a .sta or .stu file is selected and Unity Pro is not installed on the system, a popup appears 
informing the user that Unity Pro is not available and the comparison stops.
The software requires more time to compare due to the following reasons:
a. The file size or the number of variables are more.
b. .sta and .stu files as it converts the files with Unity Pro.

A popup appears to verify the login credentials of the user if the Security Editor feature is 
enabled during comparison.
If the project or section is password protected, the project file has to be unprotected and 
compared again.
If one of the selected .stu file is saved on the server, confirm that the server is accessible in 
Read/Write mode to perform the comparison.

Step Action

NOTE: The software registers the information of the detected errors and warnings in a log file during the 
comparison process. The name of the log file is UnityDifError.log and it is located at %application 
path%/UnityDIF.
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Compatibility

Introduction
The software is compatible from Unity Pro V2.0 onwards for XLs, XL, L, M, and S for the following 
Unity Pro PLC platforms:

Quantum
Premium
M340
MDI
M580

Compatibility Table
This table describes the compatibility of Unity Pro project files:

NOTE: 
The Unity Pro project files has the following features:

.stu files from previous versions of Unity Pro are not readable in the new versions.

.sta files are archive files compatible between different versions of Unity Pro.

.xef files are used for exporting the XML source format.

Unity Pro Version 
Installed

Base File Compared Files

STU n-1 STU n STA n-1 STA n XEF n-1 XEF n ZEF n-1 ZEF n

Vn-1 STU n-1 Yes No Yes Yes(*) Yes Yes(*) Yes Yes(*)

Vn STU n No Yes Yes Yes Yes Yes Yes Yes

Vn-1 STA n-1 Yes No Yes Yes(*) Yes Yes(*) Yes Yes(*)

Vn STA n No Yes Yes Yes Yes Yes Yes Yes

Vn-1 XEF n-1 Yes No Yes Yes(*) Yes Yes(*) Yes Yes(*)

Vn XEF n No Yes Yes Yes Yes Yes Yes Yes

Vn-1 ZEF n-1 Yes No Yes Yes(*) Yes Yes(*) Yes Yes(*)

Vn ZEF n No Yes Yes Yes Yes Yes Yes Yes

(*): No Unity Pro Vn feature is used in the project.
Application of level Vn: Application is developed using Unity Pro Vn.
Unity Pro Vn: Unity Pro version that supports applications of level ≤ n.
Example: If the installed version of Unity Pro is 8.0, then n = 8.0 and the last version is 7.0 (n-1 = 7.0).
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Compared Elements

Introduction
This table describes the compared sections and attributes of the project files. The remaining 
sections and attributes are not compared:

Elements Sections Compared Attributes

PLC 
Configuration

Quantum Rack Rack name
Rack position

Quantum PLC Configuration Tab
Module name
Vendor name
Version
Rack
Position
Cold Start only
Automatic start in Run
State RAM
Online modification in RUN or STOP
Maximum Unity data exchanged by PLC scan
%Mwi Reset

Quantum Drop Drop name
Hold up time
Starting address status table
Version
Rack

Quantum I/O Module name
Vendor name
Version
Rack
Position
Task
Starting address
Mapping

Quantum - 
Other modules

Module name
Vendor name
Version
Rack
Position
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continued... Premium Rack Rack name
Rack position

Premium PLC Configuration Tab
Module name
Vendor name
Version
Rack
Position
Cold Start only
Automatic start in Run
Initialize %MWi on Cold Start

Premium Drop Drop name
Version
Rack

Premium - 
Other modules

Module name
Vendor name
Version
Rack
Position

M340 Rack Rack name
Rack position

M340 PLC Configuration Tab
Module name
Vendor name
Version
Rack
Position
Cold Start only
Automatic start in Run
Initialize %MWi on Cold Start

M340 Drop Drop name
Version
Comment
Rack

M340 - Other 
modules

Module name
Vendor name
Version
Rack
Position

M580 Rack Rack name
Rack position

Elements Sections Compared Attributes
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continued... M580 PLC Configuration Tab
Module name
Vendor name
Version
Rack
Position
Cold Start only
Automatic start in Run
Initialize %MWi on Cold Start
Maximum Unity data exchanged by PLC scan

M580 Drop Drop name
Version
Rack

M580 - Other 
modules

Module name
Vendor name
Version
Rack
Position

MDI Rack Rack name
Rack position

MDI PLC Configuration Tab
Module name
Vendor name
Version
Rack
Position
Cold Start only
Automatic start in Run
Initialize %MWi on Cold Start

MDI Drop Drop name
Version
Rack
Comment

MDI - Other 
modules

Module name
Vendor name
Version
Rack
Position

Derived Data 
Types

– Name
Type
Version
Comment

Elements Sections Compared Attributes
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Derived FB 
Types

– Name
Type
Version
Comment
Value
Pin position

Variables and 
FB Instances

Elementary 
Variables

Name
Type
Address
Value
Comment
Time stamping

Derived 
Variables

Device DTT
IODTT
DTT

Name
Type
Address
Value
Version
Comment

Elementary FB 
Instances

Name
Type
Address
Value
Comment

Derived FB 
Instances

Name
Pin position
Type
Value
Comment

Motion Axis 
Parameters

Name
CANOpen handler variable name
List of compatible address
Axis reference variable name
List of available drive
Network type
Part number
Software version

Recipe 
Parameters

Recipe variable name
Parameter description
Initial values saving enabled

Elements Sections Compared Attributes
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Communication Ethernet Name
Model family
Rack
Module
Comment

IP configuration
IP Address
Subnet mask
Gateway address
Ethernet configuration

Messaging
Name
Access control
Access

IO scanning
Health block (%I/%IW)
Device control block (%MW)
Repetitive rate step
Name
IP address
Unit ID
Slave syntax
Health Timeout (ms)
Repetitive rate (ms)
RD Master object
RD Ref slave
RD length
Last value (Input)
WR Master object
WR Ref slave
WR length
Gateway/Bridge device
Description

Global data
Health timeout
Distribution period
Multicast filtering
Group address
Group name
Health bit block

Elements Sections Compared Attributes
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continued... Ethernet SNMP
IP address manager 1
IP address manager 2
Location
Contact
SNMP Manager
Set community name
Get community name
Trap community name
Enable Authentication Failure trap

Address server
Locked in operation
Password
MAC address
Name
IP address
Netmask
Gateway

NTP
IP address of Primary NTP Server
IP address of Seconadry NTP Server
Polling period
Automatically adjust clock for daylight saving

Bandwidth
Estimated publishers period (ms)
Estimated transaction received (per second)
Global data
IO Scanning
Messaging
Others

Elements Sections Compared Attributes
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continued... Modbus Plus Name
Time Out (ms)
Input fallback mode
Station number
PeerCop
Comment

Global
Name
Length
Bin/BCD

Specific
Name
Length
Bin/BCD

Fipway Name
Rack
Module
Network number
Table start address (%MW)
Product zone address (%MW)
Length of produced zone in words

Program FBD 
section/SR 
section

–

ST section/ SR 
section

IL section/ SR 
section

LD section/ SR 
section

SFC 
section/SR 
section

LL984 
section/SR 
section

Animation 
Tables

– Name
Version
Extended string animation
Extended string animation characters length

Elements Sections Compared Attributes
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Operator 
Screen

– Animation variable name
Animation variable type
Display condition
Animation display type
Animation display
Flashing background
Flash color
Number of characters
Character shift
Assosciated text
Controlled variable name
Controlled type
Controlled variable low range
Controlled variable high range
Text animation message number
Text animation message shift
Trend low threshold
Trend high threshold
Trend sampling
Trend pixels
Trend line color
Bar chart low threshold
Bar chart high threshold
Bar chart default minimum value
Bar chart default maximum value
Bar chart color
Instruction type
Channel type

DTM Catalog/
Browser

– Alias name
DTM name
DTM version
DTM creation version
Address
Device name
Device vendor
Device creation version
Is MasterDTM

Project 
Settings

– General
Operator Screens
Program
Variables

Elements Sections Compared Attributes
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Features

Section 3.4
Features

Overview
This section describes the features of this software.

What Is in This Section?
This section contains the following topics:

Topic Page

DIF Summary 49

XML Source 50

Print 51

Options 53
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DIF Summary

Introduction
This feature displays the consolidated summary of differences between the base and compared 
file in graphical format. The DIF summary is displayed by default after comparison. The user can 
view the DIF summary by choosing the root node or the required section from the Project Browser 
any time after comparison.

The selection of the root node displays the consolidated summary of difference between the base 
and compared files.

This figure displays the summary of differences between the selected files:

Features
The DIF summary view has the following features:

Displays the basic file properties and the consolidated summary of the base and compared files.
Displays the difference summary of the particular section by selecting the section header node 
from the Project Browser.
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XML Source

Introduction
This feature enables the user to view the source XML content of a selected section. The user can 
identify the possible differences in the XML sources, which are not compared during the DIF 
comparison.

This figure displays the XML view of the compared files:

To view the XML difference, click File → XML View from the menu bar or click the toolbar shortcut.

Features
The features for this option are similar to that offered in the textual representation. The DIF 
navigation keys allow the user to navigate through the differences.
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Print

Introduction
This feature enables the user to print the project differences or save the same in .txt or .pdf format.

Print
The Print dialog box lists the sections with differences. The user has the privilege to select and 
unselect the required sections. All the sections are selected to print by default.

This figure displays the Print dialog box:

This table describes how to select and unselect the sections necessary for printing:

Step Action

1 Click File → Print.
Result: The Print dialog box appears.

2 Uncheck the Select all Sections option.

3 Select the required sections in the list.

4 Click OK to confirm the print action.
NOTE: Click Cancel to abort the print.
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Print Setup
The Print Setup dialog box allows the user to select the required printer and configure the features 
that reflect when the report is printed.

The File → Print Setup menu item launches the Print Setup dialog box.

This figure displays the Print Setup dialog box:

Print Preview
The Print Preview option enables the user to preview the report prior to printing.

This table describes how to select the Print Preview option:

Save as Report
This table describes how to save the differences as a report:

The .pdf file includes the textual and graphical formats of the difference.

Step Action

1 Click File → Print.
Result: The Print dialog box appears.

2 Select the required sections in the list.

3 Click Print Preview to preview the print.

Step Action

1 Check the Save as Report option in the Print dialog box.

2 Click OK.
Result: A popup appears prompting the user to select the file type to save the 
differences. For example, .txt or .pdf.

3 Select the location and click Save.
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Options

Introduction
The Options menu enables the user to customize the following parameters:

Colors
Zoom

Colors
The color format setting helps to represent and format the differences on the Main Window. The 
colors are set as per the user preferences.

The user can set the color representation for the following parameters:
Added
Modified
Deleted
Highlight difference (for text sections)
Blank area indicator

This figure displays Colors option: 
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Zoom
This feature enables the user to synchronize the scrolling on the Main Window. Unselect this option 
to zoom and scroll the split windows individually.

This figure displays the Zoom option:
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Comparison Modes

Chapter 4
Comparison Modes

Overview
This chapter describes 2 other methods (Command-line mode and server mode) to launch 
Unity DIF. The comparison is done and the report is generated by the command-line mode. Unity 
DIF allows the command-line mode to be launched directly through the command prompt without 
an interactive window.

The comparison done by the command-line mode includes the following list of functionalities:
Launch the compare function with a parameter to display the result in the GUI.
Launch the compare function with a parameter to generate the summary report (.txt format).

NOTE: Sample projects are provided as part of the build for command-line and server modes. This 
helps the user to understand the features.

What Is in This Chapter?
This chapter contains the following topics:

Topic Page

Command-Line Mode 56

Server Mode 58
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Command-Line Mode

Introduction
The command-line mode (the Windows command prompt) is used instead of the DIF user interface 
to compare Unity Pro projects. This is useful either to integrate DIF with other applications or to 
generate DIF comparison report without user interface.

How to Launch Command-Line Mode
This table describes the procedure to execute the software in command-line mode from the 
keyboard:

NOTE: By default, UnityDIF.exe will be available in C:\Program Files\Schneider Electric\Unity Dif.

Syntax
Run Unity DIF from the command-line mode using the syntax:

UnityDif.exe [option].

Command-Line Arguments
This table describes the command-line arguments:

Step Action

1 Click Start → Run.
Result: Run dialog box appears.

2 Click OK after entering cmd in Open field.
Result: Command prompt screen appears.

3 Enter the UnityDif.exe file path in the command prompt screen.

Options Description Usage Example

-h or -? Helps to provide information about all the 
options.

UnityDif.exe -?
or
UnityDif.exe -h

-c Compares 2 Unity Pro project files and 
displays the result in the Main Window.(1)

Syntax:
UnityDif.exe -
c [/path/[base File]][/path/
[compare File]][optional:
security Editor UserName]
[optional: security Editor
Password]

UnityDif.exe -
c ~\basefile.stu ~\comparefile.stu
username password

(1) The username and password parameters are optional and required only when Unity Pro Security Editor is ON.



Comparison Modes

EIO0000001720 11/2013 57

-cr Compares 2 Unity Pro files and 
generates\stores the result in .txt format in 
the given path.(1)

Syntax:
UnityDif.exe -
cr [/path/[base File]][/path/
[compare File]][optional:
security Editor UserName]
[optional: security Editor
Password] [/path/[report Name]]
NOTE: The result is stored in the text 
format by default.

UnityDif.exe -
cr ~\basefile.stu ~\comparefile.stu
username password ~\basefile.stu ~\result

-v Validates the 2 DIF report files and saves 
the result in the given location.
Syntax:
UnityDif.exe -
v [/path/[report File]][/path/
[resultFileName.txt]]
NOTE: After the checksum verification, a 
message box appears with the result. It 
displays Identical if the report is validated 
and Different in the other case.

UnityDif.exe -
v ~\resultFile.txt ~\ ~\resultFileName.txt

Options Description Usage Example

(1) The username and password parameters are optional and required only when Unity Pro Security Editor is ON.
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Server Mode

Introduction
The server mode enables the user to develop an application using Unity DIF functions. The 
functionalities of these interfaces are same as the command-line mode parameters, but a different 
syntax is used.

Description
This table describes the interfaces:

Interface Syntax Description

int CompareFilesWithGUI
(string baseFilePath, string compareFilePath,
string userName, string password)

Compares 2 Unity Pro project files and opens the 
results in DIF window.
Parameters:

baseFilePath: Valid base file with full path.
compareFilePath: Valid compare file with full 
path.
userName: Valid Security Editor user name.
password: Valid Security Editor password.

NOTE: The valid username and password are 
required only if the Security Editor is ON, otherwise 
null is ignored.

Detected error codes:
UDS_E_SUCCESS_NO_DIFF: No differences 
between base and compared files.
UDS_E_SUCCESS_WITH_DIFF: Differences 
found between base and compared files.
UDS_E_CONVERT_FAILED: File conversion 
unsuccessful.
UDS_E_INVALID_FILE: Invalid file.
UDS_E_COMPARE_FAILED: Comparison 
unsuccessful.
UDS_E_USER_PASSWORD_NOT_VALID: Invalid 
user name or password.
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int CompareFilesWithReport
(string baseFilePath, string compareFilePath,
string reportFilePath, string userName,
string password)

Compares 2 Unity Pro project files and generates the 
report.
Parameters:

baseFilePath: Valid base file with full path.
compareFilePath: Valid compare file with full 
path.
reportFilePath: Valid path to save the result 
report.
userName: Valid Security Editor user name.
password: Valid Security Editor password.

NOTE: The valid username and password are 
required only if the Security Editor is ON, otherwise 
null is ignored.

Detected error codes:
UDS_E_SUCCESS_NO_DIFF: No differences 
between base and compared files.
UDS_E_SUCCESS_WITH_DIFF: Differences 
found between base and compared files.
UDS_E_CONVERT_FAILED: File conversion 
unsuccessful.
UDS_E_INVALID_FILE: Invalid file.
UDS_E_COMPARE_FAILED: Comparison 
unsuccessful.
UDS_E_USER_PASSWORD_NOT_VALID: Invalid 
user name or password.

int ValidateReport(string reportFilePath) Verifies the file content against checksum.
Parameters:

reportFilePath: Valid report file with full path.

Detected error codes:
UDS_E_FILE_NOT_FOUND: Report file not found.
UDS_E_FILE_DIFFERENT: Report file modified.
1UDS_E_FILE_IDENTICAL: Report file 
identical.

Interface Syntax Description
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Error Codes
The table describes the error codes that are returned by the interfaces:

Integer Values Error Codes Description

1 UDS_E_SUCCESS_NO_DIFF No differences between the 2 files.

2 UDS_E_SUCCESS_WITH_DIFF Differences found between the 2 files.

3 UDS_E_PRODUCT_TRIALPERIOD_OVER Product trial version over.

4 UDS_E_CONVERT_FAILED File conversion unsuccessful.

5 UDS_E_INVALID_FILE Invalid file.

6 UDS_E_COMPARE_FAILED Comparison unsuccessful.

7 UDS_E_USER_PASSWORD_NOT_VALID Invalid username or password.

8 UDS_E_FILE_NOT_FOUND Report file not found.

9 UDS_E_FILE_DIFFERENT Report file is modified.

10 UDS_E_FILE_IDENTICAL Report file is identical.

12 UDS_E_APP_PWD_NOT_VALID Invalid application password.
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Troubleshooting

Chapter 5
Troubleshooting

Diagnostic Management

Introduction
The reasons and solutions of the main errors detected during a comparison are described here.

Issues Detected in Standalone Mode
This table describes the reasons and solutions of possible issues detected in standalone mode or 
when it is launched from Unity Pro:

Possible Detected 
Issues

Why When Reason/Possible Solution

Installation is interrupted 
or not launching.

PC does not have the 
required operating 
system.
Older version is not 
uninstalled properly.

During installation of 
Unity DIF.

Change the operating 
system of the PC.
Uninstall the older version 
manuallly.

Incorrect element. The project file version is 
incompatible.

When you click OK to launch 
the comparison.

The version of the .stu file 
is not the same as the 
installed version of 
Unity Pro.
The version of the .xef files 
are corrupted.

The report is not 
generated.

The disk space is 
limited while generating 
the project.
Incorrect format used 
for a report validation.
Generating report with 
large number of 
modified sections.

During generation. Free the space on your 
hard disk.
The report file format has 
to be .txt.

The project name does 
not appear in the Open 
Files dialog box.

The project is not saved. When the same file that was 
compared from Unity Pro is 
selected for a new 
comparison.

Save the project before 
launching the first 
comparison.

The Project Comparison 
sub menu item is disabled 
on Unity Pro Tools menu.

Unity Pro is reinstalled. When the user tries to launch 
Unity DIF from Unity Pro.

Repair or reinstall Unity DIF.
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Issues Detected in Command-Line Mode and Server Mode
This table describes the possible issues detected in command-line mode and server mode:

Mode Possible Detected Issues Why Reason/Possible Solution

Command-line 
mode

Output is not visible at the 
command prompt.

Output is not displayed at the 
command prompt but redirected 
to the console.

Redirect output to a file.

The Unity DIF user interface is 
not displayed after using -c 
option.

The input file may be corrupt. Redirect output to a file and 
check the output file for 
detected errors indicated.

The report is not created after 
using -cr option.

The input file may be corrupt. Redirect output to a file and 
check the output file for 
detected errors indicated.

Server mode Runtime error detected during 
client execution.

The client is not present in Unity 
DIF root folder (for example, 
C:\Program Files\Schneider 
Electric\Unity Dif).

Copy the client executable and 
related files to the Unity DIF 
root folder.

Runtime error detected during 
client execution even if files are 
in Unity DIF root folder.

Incomplete registration of Unity 
DIF.

Reinstall the software.
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Glossary

D
DDT

DDT is the abbreviation of Derived Data Type.

A derived data type is a set of elements of the same type (ARRAY) or of various types (structure)

DFB
DFB is the abbreviation of Derived Function Block.

DFB types are function blocks that can be programmed by the user ST, IL, LD or FBD.

By using DFB types in an application, it is possible to:

simplify the design and input of the program,
increase the legibility of the program,
facilitate the debugging of the program,
reduce the volume of the generated code.

DFB instance
A DFB type instance occurs when an instance is called from a language editor.

The instance possesses a name, input/output interfaces, the public and private variables are 
duplicated (one duplication per instance, the code is not duplicated). 

A DFB type can have several instances.

DTM
A Device Type Manager (DTM) is a kind of device driver, which is provided by the field device 
vendor. The DTM contains the device specific information and provides a graphical user interface. 

You can use the DTM to perform monitoring and configuration tasks on the specific device. 

A DTM is not a standalone application. It always requires an FDT Frame Application to run. 
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E
EDT

EDT is the abbreviation of Elementary Data Type. 

These types are as follows:
BOOL,
EBOOL,
WORD,
DWORD,
INT,
DINT,
UINT,
UDINT,
REAL,
DATE,
TOD,
DT.

EF
Is the abbreviation of Elementary Function.

This is a block which is used in a program, and which performs a predefined software function.

A function has no internal status information. Multiple invocations of the same function using the 
same input parameters supply the same output values. Details of the graphic form of the function 
invocation can be found in the "[Functional block (instance)] ". In contrast to the invocation of the 
function blocks, function invocations only have a single unnamed output, whose name is the same 
as the function. In FBD each invocation is denoted by a unique [number] via the graphic block, this 
number is automatically generated and can not be altered.

You position and set up these functions in your program in order to carry out your application. 

You can also develop other functions using the SDKC development kit. 

EFB
Is the abbreviation for Elementary Function Block.

This is a block which is used in a program, and which performs a predefined software function.

EFBs have internal statuses and parameters. Even where the inputs are identical, the output 
values may be different. For example, a counter has an output which indicates that the preselection 
value has been reached. This output is set to 1 when the current value is equal to the preselection 
value.
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F
FBD

FBD is the abbreviation of Function Block Diagram. 

FBD is a graphic programming language that operates as a logic diagram. In addition to the simple 
logic blocks (AND, OR, etc.), each function or function block of the program is represented using this 
graphic form. For each block, the inputs are located to the left and the outputs to the right side of 
the block. The outputs of the blocks can be linked to the inputs of other blocks to form complex 
expressions.

FFB
Collective term for EF (Elementary Function), EFB (Elementary Function Block) and DFB (Derived 
Function block)

I
IL

IL is the abbreviation of Instruction List.

This language is a series of basic instructions. 

This language is very close to the assembly language used to program processors.

Each instruction is composed of an instruction code and an operand.

IODDT
IODDT is the abbreviation of Input/Output Derived Data Type. 

The term IODDT designates a structured data type representing a module or a channel of a PLC 
module. Each application expert module possesses its own IODDTs.

L
LD

LD is the abbreviation of Ladder Diagram. 

LD is a programming language, representing the instructions to be carried out in the form of graphic 
diagrams very close to a schematic electrical diagram (contacts, coils, etc.). 

LL984
LL984 is the abbreviation of ladder logic 984.

Electrotechnicians use a ladder diagram to display an electrical circuit (using electrical symbols).

Ladder diagram shows the course of events but does not show the existing wires, which connect 
the parts with each other.

A usual user interface for controlling the actions of automation devices allows a ladder diagram 
interface, so that electrotechnicians do not have to learn new programming languages to 
implement a control program.
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N
Network

Mainly used in communication, a network is a group of stations which communicate among one 
another. The term network is also used to define a group of interconnected graphic elements. This 
group forms then a part of a program which may be composed of a group of networks.

O
Operator screen

This is an editor that is integrated into Unity Pro, which is used to facilitate the operation of an 
automated process. The user regulates and monitors the operation of the installation, and, in the 
event of any problems, can act quickly and simply.

P
Protection

Option preventing the contents of a program element to be read (read protected), or to write or 
modify the contents of a program element (read/write protected). 

The protection is confirmed by a password.

S
Section

Program module belonging to a task which can be written in the language chosen by the 
programmer (FBD, LD, ST, IL, LL984, or SFC). 

A task can be composed of several sections, the order of execution of the sections corresponding 
to the order in which they are created, and being modifiable. 

SFC
SFC is the abbreviation of Sequential Function Chart.

SFC enables the operation of a sequential automation device to be represented graphically and in 
a structured manner. This graphic description of the sequential behavior of an automation device, 
and the various situations which result from it, is performed using simple graphic symbols.

SFC objects
An SFC object is a data structure representing the status properties of an action or transition of a 
sequential chart.

ST
ST is the abbreviation of Structured Text language.

Structured Text language is an elaborated language close to computer programming languages. 
It enables you to structure series of instructions.
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T
Task

A group of sections and subroutines, executed cyclically or periodically for the MAST task, or 
periodically for the FAST task. 

A task possesses a level of priority and is linked to inputs and outputs of the PLC. These I/O are 
refreshed in consequence.

V
Variable

Memory entity of the type BOOL, WORD, DWORD, etc., whose contents can be modified by the 
program during execution. 
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Index

Symbols
 hardware and software requirements

system requirements, 12

C
compare

compared elements, 40
comparing 2 files, 37
compatibility, 39

comparison modes
command-line mode, 56
server mode, 58

F
features

DIF summary, 49
options, 53
print, 51
XML source, 50

H
hardware and software requirements

installation and uninstallation, 14
license activation, 16

L
launch

launching Unity DIF, 20

O
overview

general introduction, 9

T
troubleshooting

diagnostic management, 61

U
user interface

attribute window, 29
main window, 28
menus, 31
project browser, 26
result window, 30
status bar, 35
tool bar, 33
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